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This Month’s General Meeting  
Tuesday, August 10, 2021 
will start at 3:00 P.M. @ 

FFG Christ Lutheran Church 
Social Distancing is recommended. 

Face coverings are optional 

PLATEAU PC USERS GROUP, INC 
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August 2021 
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Please Note:  Starting with the June meeting, we will stop 
having summer/winter hours. Meetings will then be  on the 
second Tuesday of each month.  Starting at 3:00 P.M.  
 
Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade TN 

What’s Coming with Windows 11 
  

Carl Nordeen will present the program on 
the upcoming Windows 11:  
 
What’s new, what’s been removed, what’s 
stayed the same? Some of the Windows 10 
components have either been removed or 
relegated to lesser importance. Others have 
been modified, while the remaining fea-
tures have been enhanced. 
 
Basically, Windows 11 is the same as  
Windows 10 with some changes. Most us-
ers should have no problem going to Win-
dows 11 if their computer specifications 
will meet those of Windows 11. 
   
These specifications will also be discussed.  

mailto:www.PPCUGinc.com
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Join the Club! 
Anyone interested to attend the general meeting or any of 
the SIG meetings as a guest will be charged $3.00 per per-
son for any or all meetings in that month. Afterwards, you 
are encouraged to become a member of the Plateau PC 
Users Group.  Our Club cannot exist without you, the 
members.  
  
Membership Dues  
Our annual dues are now payable July 1st. of each year.  
Annual  dues are $24 per single person / $30 per family.  
Persons/families joining during the fiscal year have dues 
payable as follows: 
 

 
 

 
BOARD OF DIRECTORS DISCLAIMER 

All members of the Plateau PC Users Group are willing 
to help one another in the area of advice and tutorial in-
struction over the phone.  If you should require more in-
volved services or instruction, we have a few members 
who are very knowledgeable in several areas.  As a re-
sponsible  
consumer, it is up to you to discuss, before retaining a 
member, any and ALL charges for repair services and 
time consuming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees 
for individuals for services rendered, nor the responsibil-
ity to intervene between members who enter into a con-
tract among themselves. 
 
The GAZETTE is published using the following:  Mi-
crosoft Word, Microsoft Publisher, and Microsoft Win-
dows.  The Gazette is the monthly newsletter of the Plat-
eau PC Users Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is 
made by the PPCUG, the Gazette editorial staff or its 
contributing editors.  This extends to all losses incidental 
or consequential from the use or non-use of any infor-
mation in any issue of the Gazette. 
 
All images used in the newsletter, website, blogs, class 
materials or handouts (“media”)  are obtained from a “free 
use” source, preferably images that have been released as 
“CCO Public Domain”. 

 
 
 

 

2021-2022 PPCUG, Inc. Board Members 

 Join In 
July - 
Sept 

Oct - 
Dec 

Jan - 
Mar 

Apr - 
June 

Single $24 $18 $12 $6 

Family $30 $22 $15 $7 

President Steve Rosenstein (931) 742-0151 

Vice-President/  
 

Charlie Merrick (931) 210-8013  

Treasurer John Krueger (931) 707-3677 

Acting Secretary Richard Del Frate (931) 456-2251 

Past President Carl Nordeen  (931) 456-5597 

Membership John Krueger (931) 707-3677 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 239-0877 

Directors at Large 

Gordon Botting Jim Buxton   Richard Del Frate 

Barbara Duncan Bob Willis   

   

Printed by, Business Equipment Clinic 
539 West Ave. Suite 101  Crossville TN 38557 
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** Visit the PPCUG Website ** 

At: www.PPCUGinc.com. 
 
Read all about our club activities and scheduled monthly meetings, also current and past issues of the  Gazette Newslet-
ter. Links also to the Meeting Handouts on past presentations. 
 

Send your comments and suggestions to the PPCUG Webmaster, Alan Baker 
jackal33980@gmail.com  (931) 239-0877 

How to Check if Your PC Has TPM for Windows 11 

 
ByBrian Burgess 

e f the system requirements your PC needs to run Windows 11 is TPM version 2.0. Here are use to check to see if you have it. 

Trusted Platform Module (TPM) is a security device hardwired into your computer’s CPU. For operating 
systems like Windows 10, you need to use features like BitLocker, encryption, and decryption of the hard 
drive. In fact, when Windows 8 first came out, you needed TPM version 1.2 for BitLocker. However, there 
was a workaround for Windows 8.1. But I digress…A requirement for running Windows 11 (at least from 
what we know now) is that your PC needs TPM 2.0. Here is a way to see if your PC has TPM and the ver-
sion. 

Check Using TPM Management Tool 
First, use the keyboard shortcut Windows Key + R to bring up the Run dialog. Then type: tpm.msc and hit 
Enter or click OK. 

 
 
Next, The Trusted Platform Module (TPM) utility will launch. Here you want to look for Status and TPM 
Manufacturer Information. In my example below, the status is: “The TPM is ready to use.” And the 
Manufacturer info is version 2.0. That means my CPU is good to go for running Windows 11. 

 
 
That is all there is to it. Once you have the data, you can close out of the console 
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How to Find Memory Leak in Windows 10 and Fix it 
by Peter Brown 
 
At times, certain applications on Windows 10 start using more than the usual system RAM. This causes 
the abnormality in the device, and it becomes sluggish and started to hang. Under such conditions, com-
puter users are unable to open even basic applications. This irregularity generally happens because of 
the Memory Leak in Windows 10. 
In this post, we would discuss what a memory leak is and how to fix it. 
 
  Find Out How Much vRAM Do You Have and Need? 
 
What is Memory Leak in Windows 10? 
 
In Windows 10, a memory leak is caused when an application consumes so much RAM that other  
applications cannot run because of no RAM availability.  
Every application on Windows 10 requires a certain amount of RAM to launch and run properly. Gen-
erally, applications take a few amounts of RAM so that multiple apps can run simultaneously; some 
other applications like Chrome or Photoshop are demanding and consume more RAM than other typical 
applications.  
When an application consumes more than the required amount of RAM, it is termed a memory leak.  
 
  How to Fix Computer Low on Memory in Windows 10 
 
How do I find Memory Leak in Windows 10? 
 
If your computer is misbehaving and becoming sluggish, then there is a total possibility that it might be 
because of a memory leak. To find a memory leak in Windows 10, follow these steps: 
 

1. Right-click on the Windows taskbar, and choose Task Manager. 
 

 

(Continued on page 5) 
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2. Click on the Memory tab to arrange applications in ascending order of the memory use. 
 

 
3. Analyze which applications are using a large amount of system RAM, thus causing the Memory 

Leak.  
4. You can select those applications one by one and click on End Task to close them. 

 
Use Windows Memory Diagnostic Tool 
Windows 10 comes with an in-built tool to diagnose memory problems. Here are the steps to use Win-
dows Memory Diagnostic Tool. 

1. Click on the Start button, and on the windows search box, type Windows Memory Diagnostic. 

 
 

2 Click on Restart now and check for problems. 

 
 

(Continued from page 4) 
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How to Enter Text with Your Voice on a Chromebook 

JOE FEDEWA  @TALLSHMO 
 

 
 

Typing out a message with your voice on an Android phone or iPhone is incredibly easy to do. You can do 
the same thing on a Chromebook, too, and it is easier than you might think. We will show you how it 
works. 
 
There are two methods for entering text with your voice on a Chrome OS device. Both utilize the onscreen 
keyboard, but if you’re using a physical keyboard, there are some extra steps to get to it. 
 
On a Chromebook with a Physical Keyboard 
 
We will start with the physical keyboard method. This applies to using a Chromebook as a laptop or with 
an external keyboard connected. Basically, any setup that prevents the onscreen keyboard from popping up. 
 
First, click the clock to open the Quick Settings menu, and then select the gear icon to go to the Settings 
menu. 

 

In the Settings, click “Advanced” to expand the sidebar menu, and then select “Accessibility.” 

 
(Continued on page 7) 
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Next, select “Manage Accessibility Features.” 

 
 

Scroll down and toggle the switch on for “Enable Dictation (Speak to Type).” 

 

You will immediately see a microphone icon appear next to the clock on the Shelf. Click the icon to start 
speaking on a message. 

 

A message will tell you that voice input data is sent to Google the first time that you use the voice-typing 
feature. Click “Got It” to proceed. 

 

When the microphone icon is solid, it’s listening. You can now speak, and your voice will be converted to 

(Continued from page 6) 
 

(Continued on page 8) 
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 text. When you are done talking, it will stop listening. 

 

 

On a Touch Screen-Only Chromebook 

 

The second method is for when you’re using a Chrome OS device in tablet mode. This happens if your 
Chromebook simply doesn’t have a keyboard or the keyboard is folded back or detached. 

All you have to do is tap in a text box to bring up the virtual onscreen keyboard. 

 

Once the keyboard is up, tap the microphone icon. 

 

The first time that you use this feature, a message will tell you that voice input data is sent to Google. Click 
“Got It” to proceed. 

 

(Continued from page 7) 

(Continued on page 9) 
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You can now start talking, and your words will appear in the text box. Tap anywhere on the screen to stop 
the listening. 

 
 

That’s it! It should be noted that the first method works with touch screen-only devices as well. This is a 
nice feature to have when you do not want to physically type something out. 
 
 

How to Freely Move Pictures in Microsoft Word 

MAHESH MAKVANA  @maheshhari 

 
 

By default, you can’t freely move pictures (by drag-and-drop) to any position in a Microsoft 
Word document without also placing them somewhere in the text. But with a small change, you can drag 
images anywhere.  
 
Here’s how. 
Make a Picture Freely Move in a Word Document 
Using the method below, you can move a picture anywhere you want in your Word document—outside of 
the normal flow of text. You can even place the picture on top of an existing block of text if you want. 
We’ll use a blank document to do this. Start by opening Microsoft Word on your Windows or Mac com-
puter. On Word’s first screen, select “Blank Document” to create a new document. 
 

 

(Continued from page 8) 
 

(Continued on page 10) 
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In Word’s editing window that opens, click the “Insert” tab at the top. 
 

 
 
In the “Insert” tab under the “Illustrations” section, click Pictures > This Device. This lets you add a picture 
from your computer. 
 

 
 
Use the “File Explorer” window that opens to navigate to the folder containing your picture. Double-click 
the picture to add it to your Word document. 
 

 

(Continued from page 9) 

(Continued on page 11) 
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Back on Word’s editing screen, right-click the image that you just added and select Wrap Text > In Front of 
Text from the menu. 
 

 
 

Your picture is now freely movable. Drag and drop it anywhere you want in your document. 
 

 
 
Make All Future Pictures Freely Move in a Word Document 
If you’d like to make all of your future pictures freely move in your Word documents, you can modify an 
option in Word’s settings menu. To do so, first, open Microsoft Word on your Windows or Mac computer. 
On Word’s main screen in the lower-left corner, click “Options.” 
Note: If you’re on Word’s document editing screen instead, click “File” at the top to see the “Options”  
option. 
 

 
 

(Continued from page 10) 

(Continued on page 12) 
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In the “Word Options” window, select “Advanced” in the sidebar on the left. 
 

 
 

Scroll down the right pane to the “Cut, Copy, and Paste” section. In this section, find the “Insert/Paste  
Pictures As” option and click the drop-down menu next to it. 
 

 
 
Select “In Front of Text” in the drop-down menu. 
 

 
 

(Continued from page 11) 
 

(Continued on page 13) 
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Click “OK” at the bottom of the “Word Options” window to close the window. 
 

 
 
And that’s it. From now on, Word will allow you to freely move pictures on top of text in your documents. 
 

Why You Should Update Your Web Browser 

TIM BROOKES  @TIMBROOKES 
 

  

Have you updated your web browser recently? Most browsers update themselves, but be sure to check that 
your browser is handling it! Regular updates are vital for everything, from making sure you can see the 
modern web to protecting your devices and privacy. 

 

Browser Updates Protect You 

You should be aware that running an out-of-date web browser could put your system at risk. Bad actors 
will use vulnerabilities in web browsers to target users with malware such as ransomware, privacy ex-
ploits, and other attacks. 

So-called “drive-by downloads” will attempt to download malicious content onto your computer regard-
less of whether you consent to it. All you need to do is visit a compromised website or be served a mali-
cious advert, and you don’t even need to be visiting unsavory corners of the web, since many of these at-
tacks are spread via social media. 

Then there’s the practice known as “malvertising,” which inserts malicious code into legitimate-looking 
adverts. According to a report by Confiant, 1 in 200 online advertisements is malicious. Depending on 

(Continued from page 12) 
 

(Continued on page 14) 
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where you live in the world, you might see many more malicious adverts. Patching your browser can help 
defend against such vulnerabilities, particularly once they become common knowledge. 

Extensions and plugins that you have installed alongside a browser could also pose a risk. Adobe finally 
put Flash to rest in January of 2021, with security vulnerabilities playing a large part in that decision. All 
versions of Flash since May of 2020 have had a killswitch in them that disabled the plugin permanently 
after December 31, 2020. 

If you’re running a version of Flash released prior to this (32.0.0.371 or earlier) on a browser that hasn’t 
been updated since then, you’re assuming a huge level of risk every time you browse the web. If you’re 
holding out because you’re fond of Flash, you should know that there are ways of using Flash that don’t 
put you at risk. 

Browser updates can disable extensions and plugins with known vulnerabilities or change the underlying 
code in a way that renders these exploits ineffective. 

Privacy exploits in browsers are also common. In May of 2021, FingerprintJS discovered a vulnerabil-
ity in Safari, Chrome, Firefox, and Tor Browser that could link a user’s identity across different desktop 
browsers, effectively bypassing privacy protections put in place by those same browsers. By the time Fin-
gerprintJS had discovered the issue, Chrome’s developers had already added a fix to their update 
roadmap. Of course, you won’t get the benefit if you don’t apply the update. 

Browser-based attacks can also do some pretty eyebrow-raising things when taken to extremes. There are 
many examples of devices being jailbroken that use browser exploits, such as the iPhone OS 3 jailbreak 
that exploited a flaw in the way that Safari rendered PDF files. This provided hackers with the system-
level access that they needed to install custom firmware on Apple’s smartphone. 

Even if you’re not attempting to jailbreak, from a security standpoint, Safari is probably your iPhone’s 
weakest link. 

How to Update Your Web Browser 
Most browsers update automatically in the background, but you can always force an update by manually 
checking. In some cases, browser updates are tied to operating system upgrades, with a few caveats for 
security updates. 
 
How to Update Microsoft Edge 
 
If you use Microsoft Edge, you can manually check for an Edge update by first launching the browser and 
then using the “Help” drop-down menu at the top of the window (on Windows) or screen (on a Mac), and 
then clicking the “Update Microsoft Edge” button. 

 

You can also get there using the ellipsis “…” icon, followed by Settings > About Microsoft Edge. 

(Continued from page 13) 
 

https://www.howtogeek.com/672726/how-to-update-microsoft-edge/
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Plateau PC Users Group, Inc.  
 

 Revised Application for Membership for 2021 
   
            ------- New Member    ------ Renewing Member 
 
Return this application with check foe annual dues payable to “PLATEAU PC USERS GROUP” Return to 
the club Treasurer during our meeting or mail to “PPCUG Treasurer. P.O. Box 3787, Crossville TN  38557” 
 
Our annual dues are now payable July 1st. of each fiscal year.   
Persons// families joining during the fiscal year have dues payable as follows: 
 

 
 
Date: --------------------               Amount Paid: $ --------------------   by Cash ------ , or Check (# ----------------------- ) 
 
--------------------------          -------------------------      -------------------------------------------- 
Last Name   First Name  Family Member (if family membership) 
 
------------------------------------------------------------------------------- 
Address: 
 
--------------------------------------        --------           ---------------    (-------------) ----------------------------- 
City     State  Zip Code Phone Number 
 
E-Mail address: ---------------------------------------------------------------------- 
    Please Print 
 
I have belonged to a Computer Club before:  Yes -----------     No ------------  
 
I have used PC’s since (year): ------------------  
 
I have knowledge in the following areas that I would be willing to share with club members: 
 

 
 

 
 

 
Note: Dues are now back to pre COVID-19 time, and due by July 1st 

 
July 2021 

 Join In July - Sept Oct - Dec Jan - Mar Apr - June 

Single $24 $18 $12 $6 

Family $30 $22 $15 $7 
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September 2021 

Sun Mon Tue Wed Thu Fri Sat 

   1 2:00 P.M. 

PPCUG 
Board Mtg. 

2 3 4 

5 6 7 8 9 10 11 

12 13 14 3:00 P.M. 

General Mtg. 
Presentation.  
Followed by 
Q&A Session 

15 16 17 18 

19 20 21 22 23 24 25 

26 27 28 29 30   


